
 

 

Protel 99 SE からのデザインの

転送 

概要 

Article  
AR0115 (v1.1) December 9, 2004   

このアーティクルでは、DXP 2004 デザイン環境へ Protel 
99 SE のデザインを転送する過程を説明します。 

 

 
Protel 99 SE では、デザインファイルを保存する為にデ

Protel 2004 など DXP 2004 製品では、ハードドライブに

トの概念も含まれます。99 SE インポートウィザード（

99 SE デザインデータベースを Protel 2004 にインポー

Design Workspace と Projects にな

Protel 99 SE では、一つのデザインデータベース内に全

ータベースは、保存場所としてや設計者がプロジェクト

る方法としても利用します。 

デザインデータベースに保存されるファイル、またはデ

ォルダにグループ化されるか過度に心配する必要はあり

ンに一つの DDB を使用し、その他は一つの DDB で全て

あるいは、一つの DDB に一つの製品の全てのボードデ

Protel 2004 では、全てのデザインファイルはハード

ドライブに保存されます。Protel 2004 で作成される

全てのデザインの基準は、プロジェクトファイルで

す。サポートしているプロジェクトの種類は、以下

の様になります。: 

• 
• 
• 
• 
• 
• 

PCB projects (*.PrjPcb) 
FPGA projects (*.PrjFpg) 
Embedded projects (*.PrjEmb) 
Core projects (*.PrjCor) 
Integrated libraries (*.LibPkg) 
Script projects (*.PrjScr) 

スクリプトプロジェクトを除いて、基本的に必要な

ことは、各プロジェクトは一つの実行を目的として

いることです。 – 例えば、PCB プロジェクトは一つ

の PCB を定義する為に必要な全てのソースを含み、

FPGA プロジェクトは一つの FPGA で実行されます。
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Protel 99 SE からのデザインの転送 

プロジェクトファイルは、プロジェクトにあるドキュメントへのリンク、出力設定、編集設定、エラ

ーチェック設定などの様なプロジェクト情報を保存する ASCII ファイルです。 
プロジェクトファイルは、プロジェクトにあるドキュメントへのリンク、出力設定、編集設定、エラ

ーチェック設定などの様なプロジェクト情報を保存する ASCII ファイルです。 

  
Protel 2004 では、プロジェクトファイルの上階層は Design Workspace を使用します。Design 
Workspace (.DsnWrk)は、関連したプロジェクト（クライアントの全てのプロジェクト、製品の全て

のボードなど）を一緒にまとめる為に使用されます。Design Workspace を開くと、その Workspace
にある全てのプロジェクトが Protel 2004 の Projects パネルに表

Protel 2004 では、プロジェクトファイルの上階層は Design Workspace を使用します。Design 
Workspace (.DsnWrk)は、関連したプロジェクト（クライアントの全てのプロジェクト、製品の全て

のボードなど）を一緒にまとめる為に使用されます。Design Workspace を開くと、その Workspace
にある全てのプロジェクトが Protel 2004 の Projects パネルに表

図 1 は、99 SE デザインデータベースから Protel 2004 での同等の
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含む各フォルダの為に、Library Package はライブラリを含む各フ

を Workspace にマッピングする以外は、インポート中に全てのマ
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Protel 2004 では、回路図、PCB、HDL または、その他のデザイン

きますが、回路図からボードに更新したり、プロジェクト内の全て

クトタイプの操作を実行するには、プロジェクトを開く必要があり

Protel 2004 では、回路図、PCB、HDL または、その他のデザイン

きますが、回路図からボードに更新したり、プロジェクト内の全て

クトタイプの操作を実行するには、プロジェクトを開く必要があり

Protel 99 SE Windows File System デザインも、Access® Databa
SE Import Wizard を使用してインポートすることができます。 
Protel 99 SE Windows File System デザインも、Access® Databa
SE Import Wizard を使用してインポートすることができます。 

もし、Protel 2004 で、簡単な例を使用して全体の PCB デザイもし、Protel 2004 で、簡単な例を使用して全体の PCB デザイ

デザイン入門 のチュートリアルを参照して下さい。 

99 SE Design Database のインポート 
サービスパック 2 では、インポート過程を完全に制御するこ

とができる 99 SE Import Wizard が導入されました。99 SE デ
ータベースをインポートするには、メニューから File » Protel 
99 SE Import Wizard を選択します。インポート過程では、現

在、Protel 2004 で開いている全てのファイル、プロジェクト

やデザインワークスペースを閉じておく必要があります。もし、

閉じていない場合は、最初に閉じるように促されます。 
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Wizard では、一つの DDB をインポートする為、またはフォル

ダ内の全ての DDB をインポートする為に使用することができ

ます。このアーティクルでは、一つの DDB をインポートした

場合について説明します。 

Wizard は、次のステップで実行します: 

1. ハードドライブの指定したフォルダ内のデータベースから

ファイルを抽出して下さい。データベース内のフォルダ構

造は、ハードドライブで再度、作成されます。データベー

ス内の全てのファイルは、プロジェクト構造の一部である

かそうでないかに関わらず抽出されます。 

2. 現在のファイル形式に回路図ドキュメントを変更して下さ

い（このオプションが有効な場合）。 

3. 全ての回路図と PCB ファイルに、認識されたファイル拡

張子を追加して下さい。Protel 2004 は、編集できるドキ
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ュメントを認識する為にファイル拡張子を使用します。回路図の場合、この拡張子は Sch, 
SchDoc、または original DOS schematic S01, S02 などの決まった名称である必要があります。

もし、DDB 内に拡張子が無い回路図がある場合、.SchDoc がファイル名に追加されます。これは、

階層を崩さないことに注意して下さい。Protel 2004 コンパイラは、自動でこの状態を検知し、デ

ザイン階層と接続を維持します。標準のファイル拡張子では無い Altium で作成していないファイ

ルは、自動で名称は変更されないことに注意して下さい。 

4. 各指定したプロジェクト（PrjPcb タイプ (PCB プロジェクト) または LibPkg (ライブラリ・パッケ

ージ)）のプロジェクトファイルを作成して下さい。そして、関連したプロジェクトファイルを追

加して下さい。 

5. Design Workspace (DsnWrk)を作成し、作成したプロジェクト全てをそれに追加して下さい。 

6. Design Workspace を開いて下さい。作成した Design Workspace を開くと、構築された全ての

Protel 2004 プロジェクトを表示します。図 2 は、Protel 99 SE \Examples フォルダに含まれる 
Z80 Microprocessor デザインをインポートした結果を示します。 

Protel 2004 プロジェクトの作成 

• 

• 

Wizard のページを通して作業する場合、Set Import Options ページで以下のオプションを選択しま

す: 

Create one DXP project for each DDB – 一般的に、各ボードデザインの DDB を使用する場合、

このオプションを選択して下さい。 

Create one DXP project for each DDB folder – DDB がボードデザイン以上、含まれている場合、

このオプションを選択して下さい。 

DDB をどのように使用するか最も適切なものを選択して下さい。Wizard の後半の Review Project 
Creation ページで調整することができます。  
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図 4. Review Project Creation オプションを使用して、各ファイルが 2004 プロジェクトにどのようにマップされる

かを正確にコントロール。 

図 3 の様に、Review Project Creation ページでは、DDB の内容に基づいたプロジェクトをどのよう

に構築すべきかについて Wizard で作成した内容が表示されます。 これらのオプションを設定するに

は時間がかかります。インポート過程の完成で、最善の結果に達成することを確実にします。 

プロジェクトからマニュアルでファイルを追加、削除 

一度 Wizard が完了すれば、図 4 の例で示す様にプロジェクトやそれらのドキュメントが Protel 2004
に読み込まれます。回路図プロジェクトの階層は、プロジェクトが初めてコンパイルされるまで表示

されないことに注意して下さい。 

インポート後にドキュメントがプロジェクトに正しく割り当てられないことに気づいた場合、それら

を整理する為に次の方法を使用して下さい: 

• 

• 

• 

ファイル名をクリックしてからドラッグアンドドロップして、あるプロジェクトから他のプロジェ

クトへファイルを移動するか、または Ctrl を押しながら双方のプロジェクトに入れて下さい。 

ファイル名をクリックして右クリックメニューから Remove from Project を選択し、プロジェク

トからドキュメントを削除して下さい。 

プロジェクトファイルをクリックして右クリックメニューから Add Existing to Project を選択し、

プロジェクトにミスしたファイルを追加して下さい。ドキュメントは、Protel 2004 ファイルとし

て認識させる為に適切なファイル拡張子を持つ必要があることを思い出して下さい。 
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• プロジェクトに新規のファイルを追加するには、プロ

Add New to Project を選択して下さい。 
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ジェクト名を右クリックしメニューから
 5. Z80 の DDB をインポート直後の例。元の

DB に、2 つの PCB デザインが含まれていること

注意して下さい。それらは、それぞれ DXP 2004
ロジェクトになります。 
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ファイル形式の変更 ファイル形式の変更 

回路図、回路図ライブラリ、PCB、PCB ライブラリのファイル形式は、Protel 99 SE で使用された形

式から変更されます。 

Protel 2004 で直接、99 SE 形式の回路図、回路図ライブラリファイルを開き、使用することができま

すが、ファイルを保存する時はいつでもファイル形式を変更することができます。 

99 SE PCB ファイルは、編集する前に Protel 2004 ファイル形式に変更する必要があります。古い形

式の PCB を開く時はいつでも PCB Import Wizard が起動しますので、ウィザードに従って設定しま

す。 

次の項目では、オブジェクトの様々な相違とデザインでどのように扱うかについて解説します。これ

らを知っておくことは重要です。 

コンポーネント 

コンポーネントは、DXP バージョンで非常に進歩しました。制限の無いコンポーネントパラメーター

をサポートし、PCB フットプリントを視覚的に検索する機能の様な、改良されたモデル定義やリンク

するシステムを持っています。 

コンポーネントを編集する為にダブルクリックすると、全ての 99 SE Text fields と Part fields がパラ

メーターに変更されていることに気づくでしょう。99 SE では、コンポーネントごとに 8 個の Text 
fields と 16 個の Part fields をサポートしていますが、Protel 2004 では追加できるパラメーター数に制

限はありません。 

パラメーターは、Protel 2004 デザインで任意の目的に使用できます。それらは、DbLink ドキュメント

を使用して会社のデータベースにリンクすることもできます。パラメーターは、プロジェクトに

OutJob ドキュメントを追加し、要求した出力形式でレポートを作成する為のレポートエンジンを設定

して、プロジェクトから作成したレポートに含めることができます。パラメーターは、データベース

や web URL にリンクする為に使用することもできます。 

コンポーネントの作成とモデルの追加の詳細については、ライブラリコンポーネントの作成 のチ

ュートリアルを参照して下さい。 

コンポーネントからデータベースにリンクする詳細については、データベースからコンポーネント

へのリンク のチュートリアルを参照して下さい。 

Protel 2004 デザインからレポートを作成する詳細については、部品レポートのカスタマイズ のチ

ュートリアルを参照して下さい。 

パラメーターからデータベースにリンクする概要については、New and Enhanced Features in 
SP2 のアーティクルを参照して下さい。 

ライブラリ 

Protel 2004 は、ライブラリの操作について広い解決策を持っています。Protel 2004 は、従来の独立し

た回路図シンボルと PCB フットプリントライブラリをサポートしているのはもちろん、シンボルと一

つのコンパイルしたファイルに全てのモデルを含んでいる新しい統合ライブラリもサポートしていま

す。  
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インストールしたライブラリに利用できるコンポーネントを制限するのではなく、Protel 2004 では、

プロジェクトの一部であるどんなライブラリも自動で利用できます。また、モデルへの検索パスもサ

ポートしています。 

インストールしたライブラリも Available Libraries ダイアログの Installed Libraries のリストに表示さ

れた順番で検索されます。更に、Available Libraries ダイアログでは、どの project libraries が利用でき

るか、どのプロジェクト検索パスが定義されたか表示されます。このダイアログの 3 つの異なる場所

でのコンポーネント/モデルの検索は、タブ内のリストの順番に依存することに注意して下さい。 

 
図 6. Available Libraries ダイアログでは、全てのライブラリとアクティブなプロジェクトで利用できるモデルファ

イルが表示されます。検索順番は、左から右へ、上から下へとなっています。 

コンポーネントとライブラリの背景的な情報については、コンポーネントのモデルとライブラリの

ライブラリの概念 のアーティクルを参照して下さい。 

統合ライブラリの詳細な情報については、統合ライブラリの作成 のチュートリアルを参照して下

さい。 

リンクと Unique ID 
99 SE と Protel 2004 の双方で、コンポーネント・デジグネータがエディタで修正されていても、

Unique ID の値は回路図と PCB オブジェクトを互いに関連付けしておくことができます。 

しかし、99 SE デザインをインポートする時に、回路図と PCB のコンポーネント間の全てのリンクが

切れることに気づくでしょう。UID リンクの再確立は簡単ですが、それはデジグネーターに基づいて

なされる必要があります。 

最初に、回路図エディタメニューから Tools » Convert » Reset Component Unique IDs を選択して、

回路図側の全ての Unique ID の値をリセットします。 それから、PCB 側で Component Links ダイア

ログ(PCB エディタメニューの Project » Component Links)にてフットプリントと共にコンポーネン

トをペアにします。完全に同期した 99 SE データベースでは、これを 2 つの過程で行うべきです: 最
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初に、一致するデジグネーターによりペアを作成し（デフォルトの相互関係）、それから更新を実行

します。 

Protel 2004 と 99 SE 間の根本的な相違は、リンクの確立は同期させる為の先行条件ではないと言うこ

とです。例えば、もし上記で述べた順序を省略し、99 SE から Protel 2004 に移行した PCB デザイン

で更新/インポートコマンドを実行しようとした場合、Unique ID による同期は失敗しますが、デジグ

ネーターにより一致させる様、通知されます。この過程を繰り返すならば、同じ状態が報告されるこ

とを意味し、そうすることはデザイン内の Unique ID の領域で効果がありません。回路図コンポーネ

ントと PCB フットプリントに同じ Unique ID の値を割り当てることは、それらの間で根強いリンクを

作成する唯一の方法です。 

ネット識別スコープ 

回路図プロジェクトにネット識別スコープが適切に設定されているかもしれません。これは、デフォ

ルトでは Options for Project ダイアログで automatic (based upon design contents)に設定されていま

す。これは、プロジェクトに、シートエントリがあるシートシンボルが存在する場合、スコープは

Hierarchical (sheet entry <-> port connections)に設定されることを意味します。プロジェクトにポート

があり、シートエントリが無い場合、スコープは Flat (only ports global)に設定されます。プロジェク

トにポートもシートエントリも無い場合は、ネットラベルがグローバルになります。 

この自動検出設定を使用したくない場合は、ここでプロジェクトに適した設定を割り当ててください。

これは、このスコープが DXP の自動検出では利用できない為、ポートとネットラベルの両方を Global
スコープとして使用している 99 SE のプロジェクトで推奨されます。 

Protel 2004 (SP2 で適用された)では、トップシートが無いフラットプロジェクトもサポートすること

に注意して下さい。このオプションを調べるには、フラットデザインからトップシートを削除し、再

度、コンパイルしてみて下さい。Protel 2004 の Navigator パネルには、デザインの接続構造が表示さ

れます（デザインの接続を調査することができます）。 

PCB インポートウィザード 
DXP で旧バージョンの PCB ファイルを初めて開く場合は、インポートウィザードが起動し、ボード

シェープ、スプリットプレーン、デザインルールの変換が行われます。 

ボードシェープ 

DXP の PCB デザインではボードシェープが必要です。これは DXP の新機能で、Protel の旧バージョ

ンのファイルに対しては追加する必要があります。 

インポートウィザードでは、すべてのデザインオブジェクトを囲む四角形を利用するか、より正確な

形状を作成する為にデザイン内に定義されている基板形状に基づいたものを利用するという 2 つのオ

プションが用意されています。後者のオプションを選択すると、Keep-Out か Mechanical レイヤに配

置されているオブジェクトが解析されます。選択したオプションに従い、プレビュー画面にボードシ

ェープが表示されます。もし、正確に表示されず Rectangular オプションを選択した場合、Protel 
2004 でボードシェープを設定する為の Design » Board Shape メニューオプションを使用します。 

ボードシェープは、物理的な基板の外形を定義し、インターナルプレーンのプルバックの形状として

使用されます。プレーンはネガティブイメージになり、プルバックによって基板端とプレーンとの間

で細い銅箔の無いエリアを作成し、作成した基板の端でショートするのを防ぐ為です。これらのトラ
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ックは、プレーンレイヤ上で直接編集することはできませんが、ボードシェープは、DXP でいつでも

定義することができ、プルバックもそれに伴い変更されます。インポートウィザードで最初に設定し

たプルバックの値は、レイヤスタックマネージャーで変更することができます。 

スプリットプレーン 

DXP では、スプリットプレーンの設定方法が変更されています。以前は、各スプリットプレーンはイ

ンターナルプレーンレイヤに閉じた領域として作成する必要がありました。対照的に、Protel 2004 で

プレーンレイヤの領域を分離するには、ライン、アークやフィルを配置することによりブローアウト

（自由な銅箔領域）を定義して、プレーンを分割します。プレーンレイヤに配置するたびにプレーン

は分析され、全ての分離した領域が検出されます。それにネットを割り当てるには、領域をダブルク

リックします。これらのブローアウト部分は、特定のスプリット領域に属していません。Protel 2004
のデザインでは、隣接するスプリットプレーンを正確になぞるような作業は不要です。Protel 2004 で

は、ネストしたスプリット領域を定義することもサポートします。 

これに関して例外がひとつあります。PCB インポートウィザードでは、以前のスプリットプレーンの

モードで扱うことができます。以前のデザインでプレーンを含んだものをインポートする際に問題が

発生した場合やスプリットプレーンを含んだ PCB を初期のバージョンで更なる編集が必要な場合には、

このモードを選択する必要があります。その後、デザインを DXP のプレーンモードに変換しても構い

ません。一方、新規のスプリットプレーンはブローアウトから推測するのではなく、インターナルプ

レーンで境界線を閉じる様に配置する必要があります。 

デザインを新しい方法に変換すると、スプリットプレーンの定義を簡単にすることができます。DXP
ではこれまでのスプリットプレーンも動作するので、必須ではありませんが、無駄なトラックが残っ

ていることで複雑な計算が必要になります。99 SE のスプリットプレーンの定義を DXP で更新するい

ちばん簡単な方法は、新しいプレーンを追加し、そこで既存の領域をトレースすることです。これを

行い、前のプレーンレイヤのオブジェクトをすべて選択し、削除します。その後で、そのレイヤに割

り当てたネットを未接続にすれば、レイヤはレイヤスタックマネージャで削除できます。最後に、各

スプリットプレーンの領域でネットが正しく割り当てられているか、各領域をダブルクリックするか

PCB パネルの Split Plane Editor を使用するかでチェックします。 

From Tos 
99 SE で特定のパッド間を定義した From-tos は、Protel 2004 で再度、定義する必要があります。こ

れは、Protel 2004 の PCB パネルで From-To Editor モードに切り換えて実行できます。 

PCB デザインルール 
Protel 2004 でのその他の変更点は、クエリを使用して定義するデザインルールの scope です。全ての

既存のルールは正確にインポートされますが、ダイアログの一連のタブとドロップダウンを選択して

構築した以前の scope は、InNet(GND)の様な簡単なクエリで表示されます。全体のボードに対するル

ールを適用するには、デフォルトのスコープ（All）を利用します。 

以前の Protel 形式の PCB デザインを Protel 2004 で開くと、ルールの優先順位と共にこのルール-スコ

ープの変換が自動で行われます（スコープの重複を解決する為に）。ルールの優先度を制御する機能

で結合されたこの新しいスコープシステムは、PCB デザインの要求を特定してより優れた制御を提供

します。 
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特別なルール変換 特別なルール変換 

Protel の旧バージョンでは、パッドの設定として一般的なマスクエクスパンションルールを無効にす

ることはできませんでした。このため以前のデザインでは単独のパッドだけを対象としているソルダ

ーやマスクエクスパンションルールがあるかもしれません。インポートウィザードでは、デザインの

このようなルールを検出し、デザインルールではなくパッドの設定に変換するようになっています。

これにより、デザインルールの設定を簡単にします。また、以前の Protel では、ビアはプレーンに接

続できなかったバージョンがあり、このためインポートウィザードは、プレーンからビアを未接続に

する新しいルールを作成する機能もあります。 

Protel の旧バージョンでは、パッドの設定として一般的なマスクエクスパンションルールを無効にす

ることはできませんでした。このため以前のデザインでは単独のパッドだけを対象としているソルダ

ーやマスクエクスパンションルールがあるかもしれません。インポートウィザードでは、デザインの

このようなルールを検出し、デザインルールではなくパッドの設定に変換するようになっています。

これにより、デザインルールの設定を簡単にします。また、以前の Protel では、ビアはプレーンに接

続できなかったバージョンがあり、このためインポートウィザードは、プレーンからビアを未接続に

する新しいルールを作成する機能もあります。 

シミュレーションモデルの参照と設定 シミュレーションモデルの参照と設定 

99 SE のコンポーネントの特定の領域にシミュレーションデータが保存されています。これらの項目

にシミュレーションデータが含まれている場合、Protel 2004 では、それらの値をそのコンポーネント

に関連するシミュレーションモデルに変換します。 

99 SE では、全てのシミュレーションモデルが SimulationModels.ddb 内に保存されていました。一方、

Protel 2004 ではプロジェクトにモデルを含めたり、必要な場所にシミュレーションモデルを保存して

おきたい場合、プロジェクトの検索パスを定義することができます。更に、シミュレーションモデル

を扱うその他の方法として、統合ライブラリ（シミュレーションモデルは、シンボル、フットプリン

ト、コンポーネントにリンクしたその他のモデルと一緒に統合ライブラリファイルへコンパイルされ

ます。）を構築することです。 

99 SE の全てのコンポーネントは、回路図コンポーネントからシミュレーションモデルにリンクする

為に定義したモデルパスを使用する為、99 SE のシミュレーションを DXP で作業する為の一番簡単な

方法は、99 SE のシミュレーションモデルデータベースから全てのフォルダとモデルを

\Altium\Library\Sim フォルダにエクスポートすることです。 

Protel 2004 では、フルパスを使用してモデルを参照することをサポートしています。Protel 2004 へ

99 SE のシミュレーション用回路図コンポーネントをインポートすると、シミュレーションモデルリ

ンクは自動的に Model Location の項目で Full Path に変換されます。Protel 2004 では、フルパスモデ

ルロケーションを検索する場合は、常に\Altium2004\Library\フォルダを含む内部的なチェックを行い

ます。99 SE のデザインをシミュレーションする場合は、シミュレーションモデルが新しい場所にあ

るかどうか確認してください。 

99 SE では、Analysis Setup ダイアログで設定した内容をデータベース内の設定ファイル (.cfg)に保存

されています。Protel 2004 で初めてデザインのシミュレーションを行う時に、シミュレーション用の

パラメーターが設定されていない場合は、この.cfg ファイルを検索し使用します。新規の 2004 プロジ

ェクトを保存する際に、シミュレーションの設定はプロジェクトファイルに書き込まれ、前の.cfg フ

ァイルは、不要になります。 

回路シミュレーションを実行する詳細については、回路シミュレーション解析の設定と実行 のチ

ュートリアルを参照して下さい。 

マルチチャンネル デザイン 

最も注意が必要な PCB プロジェクトは、マルチチャンネルデザインです。 

99 SE におけるマルチチャンネルデザインでは、実際に子シートのコピーが作成され、シートシンボ

ル別に部品番号が再割付けされています。Protel 2004 では、同じ子シートを繰り返し参照する為、最
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初に回路図の変更が必要になります。最初に、プロジェクトから、コピーした子シートを一枚だけ残

して、それ以外を削除します。残った一枚の子シートに対応しているシートシンボルの名前を更新し

ます。 

しかし、より賢明な手順は、各チャンネル用のシートシンボルを一枚だけ残し、それ以外は削除して、

Name の項目を適切な Repeat コマンドに置き換えることです。この方法では、後でチャンネル数に変

更があった場合でも、ひとつの項目を変更するだけで済みます。Repeat コマンドは、ネットに対して

も適用されます。詳細は Multi-Channel Mixer.PrjPcb を参照してください。 

PCB レイアウトに‘チャンネル’情報を移行したり、チャンネルの配置や配線、全ての他のチャンネ

ルの配置や配線を繰り返す機能を含む、マルチチャンネルデザインに関連した多数の機能がありま

す。マルチチャンネルデザインで作業する詳細な情報については、マルチチャンネルデザインの作

成 のチュートリアルを参照して下さい。 

デザインの出力 

99 SE で作成された CAM Manager (.cam)と Power Print Configuration (.ppc)ファイルは、Protel 2004
では認識されません。その為、出力するには、インポートしたデザインで再度、設定する必要があり

ます。 

Protel 2004 では、出力を設定する為に 2 つの方法があります: 回路図と PCB エディタメニューから定

義した設定は、Project ファイルに保存されます。または、プロジェクトに output job ファイル

(.OutJob)を追加することができます(Project ファイルを右クリックし、メニューから Add New to 
Project を選択します)。プロジェクトに、印刷や CAM 設定を含んでいる多数の Output job ファイル

を追加することができます。プロジェクトに、多数のデフォルト job 設定を含める為に新規の OutJob
を追加しても、 OutJob ファイル内のリストを選択し(Ctrl+A)、Delete キーを押して全て削除すること

ができます。 

99 SE にデザインを戻す 
回路図と PCB エディタにて、回路図、回路図ライブラリ、PCB、PCB ライブラリファイルを V4 (99 
SE)形式で保存することができます。99 SE に戻せないデータは以下になります。Data that can not be 
transferred back includes: 
• 

• 

• 

• 

注記、コンパイルマスク、パラメータセット・オブジェクトやオフシートコネクタを含む新規の回

路図デザインオブジェクト 

regions、solid polygon pours (従来のハッチ形状のポリゴンは、変換できます)、ボード外形、寸法

線、複合のパッドスタックを含む新規の PCB デザインオブジェクト 

99 SE のデザインルールにマップできないデザインルール 

スプリットプレーンの定義(Protel 2004 は、プレーンレイヤに配置されたオブジェクトに基づいた

分割領域を計算します。それは、分割領域を定義するのに空のポリゴンを使用しません。) 
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更新履歴 

Date Version No. Revision 

9-Dec-2003 1.0 New product release 

9-Dec-2004 1.1 Updated for DXP 2004 SP release 
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